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Introduction

by Jes-Soft

Baseball Playbook is a tool to help coaches define, draw
and share baseball plays and drills.

Baseball Playbook has the following features: 

An easy to use design tool to sketch baseball plays and
drills.

An animation screen to help you follow the flow of plays.

Storing of plays in a database ordered in categories you
define.

A text editor to describe your plays and drills.

Export and import functions to exchange plays with other
users of this program.

Printing of graphics in high quality.

Creation of play lists to prepare your practice.



All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the
written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.

Printed: April 2010 

Baseball Playbook

Publisher
Special thanks to:

All the people who contributed to make this the product it is now.
Jes-Soft

Author

Erik Smit



Baseball Playbook4

Table of Contents

Foreword 0

Part I The Main Screen 8

................................................................................................................................... 81 The overview tab

................................................................................................................................... 92 The edit drawing tab

.......................................................................................................................................................... 11Add formation 

.......................................................................................................................................................... 12Edit player 

.......................................................................................................................................................... 13Edit line 

.......................................................................................................................................................... 14Edit ellipse 

.......................................................................................................................................................... 15Edit polygon 

.......................................................................................................................................................... 16Edit text 

................................................................................................................................... 173 The edit text tab

................................................................................................................................... 184 The play list tab

Part II File Menu Options 21

................................................................................................................................... 211 Adding a new play

................................................................................................................................... 222 New play from template

................................................................................................................................... 223 New play list

................................................................................................................................... 224 Open plays

.......................................................................................................................................................... 23New play name 

................................................................................................................................... 235 Open play list

.......................................................................................................................................................... 24Skip replace play window 

................................................................................................................................... 246 Save plays

................................................................................................................................... 257 Save play list

................................................................................................................................... 258 Export

.......................................................................................................................................................... 25Exportplay 

......................................................................................................................................................... 26Exportplayhtml

......................................................................................................................................................... 27Exportplaypdf

......................................................................................................................................................... 28Exportplaygif

......................................................................................................................................................... 29Exportplayflash

.......................................................................................................................................................... 29Exportcategory 

......................................................................................................................................................... 30Export category html

......................................................................................................................................................... 31Export category pdf

................................................................................................................................... 329 Export play list

.......................................................................................................................................................... 32Export list html 

.......................................................................................................................................................... 33Export play list pdf 

................................................................................................................................... 3410 Play info

................................................................................................................................... 3511 Copy plays

................................................................................................................................... 3512 Delete plays

................................................................................................................................... 3613 Rename plays

................................................................................................................................... 3714 Print

.......................................................................................................................................................... 38Printer setup 



5Contents

................................................................................................................................... 3815 Print play list

................................................................................................................................... 3916 Send play

.......................................................................................................................................................... 41e-mail address book 

......................................................................................................................................................... 42select e-mail addresses

......................................................................................................................................................... 43select edit mail groups

................................................................................................................................... 4317 Backup

.......................................................................................................................................................... 44Backup database 

.......................................................................................................................................................... 44Backup category 

................................................................................................................................... 4518 Exit program

Part III Edit Menu Options 47

................................................................................................................................... 471 Save selection as formation

................................................................................................................................... 472 Undo

................................................................................................................................... 483 Redo

................................................................................................................................... 484 Undo history

................................................................................................................................... 485 Copy, cut  and paste

Part IV Option Menu Options 51

................................................................................................................................... 511 Flip sketch

................................................................................................................................... 512 Mirror sketch

................................................................................................................................... 513 Change font

................................................................................................................................... 524 Change symbols

................................................................................................................................... 535 Field color

................................................................................................................................... 536 Preferences

.......................................................................................................................................................... 54Default font 

.......................................................................................................................................................... 55Mail identity 

......................................................................................................................................................... 56SMTP server settings

.......................................................................................................................................................... 57Export settings 

.......................................................................................................................................................... 58Miscellaneous settings 

................................................................................................................................... 597 Default colors

.......................................................................................................................................................... 59Change default field colors 

.......................................................................................................................................................... 60Change default player colors 

Part V List Menu Options 63

................................................................................................................................... 631 Add play to play list

................................................................................................................................... 632 Add category to play list

................................................................................................................................... 633 Clear play list

Part VI Special Menu Options 65

................................................................................................................................... 651 Animation

................................................................................................................................... 662 Plugin

Part VII Miscellaneous 68

................................................................................................................................... 681 Trial period



Baseball Playbook6

................................................................................................................................... 682 Adobe Acrobat Reader

................................................................................................................................... 683 Baseball playbook homepage

................................................................................................................................... 694 Drag and drop

................................................................................................................................... 695 Drawing lines

................................................................................................................................... 696 E-mail attachments

................................................................................................................................... 697 Gif file format

................................................................................................................................... 698 Load backup file

................................................................................................................................... 709 Logo

................................................................................................................................... 7110 Printing a play or the complete playbook

.......................................................................................................................................................... 72Printer mode 

................................................................................................................................... 7311 Register

................................................................................................................................... 7312 Selecting players

................................................................................................................................... 7413 Shortcut keys

................................................................................................................................... 7614 Text edit buttons

................................................................................................................................... 7715 The symbols

................................................................................................................................... 7816 Zip and unzip

................................................................................................................................... 7817 Abbreviations

Part VIII Frequently Asked Questions 80

................................................................................................................................... 801 How do I complete the registration process ?

................................................................................................................................... 802 How do I download and open additional plays and drills ?

................................................................................................................................... 803 How do I submit a play ?

................................................................................................................................... 81
4 Players/lines that are placed on a court will not go onto the

court where I want them.

................................................................................................................................... 815 Error on loading Winsock2 library (WS2_32.DLL)...

Index 82



Part

I



Baseball Playbook8

1 The Main Screen

1.1 The overview tab

When the overview tab is selected the sketch and the text of the current drill is visible.

On the overview tab you can add a play or category to the play list by bringing up the pop-up menu
and selecting, add play to play list or add category to play list.

The type box can be used to switch between plays, drills, templates and formations.
If the play Type is Template a "New Play" button is visible so you can create a new play from the
current template.

With the category box categories within the play or drill section can be selected.

With the play name box the different plays within the current category can be selected.

And finally with the sequence buttons you can navigate through the current play.
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1.2 The edit drawing tab

With the edit drawing tab selected a sketch of the current drill can be edited.

The players, balls and coaches can be selected and dragged and dropped over the field, with the
main mouse button.
To select multiple players and lines, lines hold down the CTRL button while clicking on the
players/lines.
You can also select an area of the field by holding down the shift key and using the main mouse
button to resize a selection rectangle.
Finally all players/lines can be selected by choosing Edit - Select All or by pressing CTRL-A. 

When a player is selected with the other mouse button, a player edit window is shown and
depending on the player the color, text or rotation can be altered.

The movement of players and balls can be drawn with the 7 different arrows. The ellipse and
polygon can be used to give a part of the field a different color. The text button can be used to add
text to a sketch.

To make curved lines check the curve checkbox, to align players and lines check the snap function
and select the size of an invisible snap grid. 

See the symbols for an explanation of the different graphics.
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If the previous position checkbox is checked the players of the previous sequence are drawn in light
gray.

With the previous lines checkbox you can show or hide the lines of a previous sequence, if there are
no lines in the previous sequence the sequences before that will be checked for lines.

If the Animation only checkbox is checked the current sequence will not be printed.

The Add Formation button, will show a number of predefined formations which can be used in the
current sketch.

The Delete button will delete selected players or movement lines.

The Add Sequence button can be used to insert a new sequence after the current sequence. The
maximum number of sequences per play is 75.

And the Delete Sequence button can be used to delete the current sequence.

Clicking on the Field tab will enable you to choose a different field, browsing through the different
fields is done by pressing the navigation buttons. By pressing the Ok button the field in the drawing
is replaced by the selected.

The type box can be used to switch between plays, drills, templates and formations.
If the play Type is Template a "New Play" button is visible so you can create a new play from the
current template.

With the category box categories within the play or drill section can be selected.

With the play name box the different plays within the current category can be selected.

And finally with the sequence buttons you can navigate through the current play.
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1.2.1 Add formation

The add formation window shows a number of predefined formations which can be used in the
current sketch.

To use a formation change the Category and select a formation from the list. Press the Ok button
and the formation will be added (selected) to the current sequence.

As the formation will be selected, you can move the formation with the arrow keys or by dragging a
selected player to its new position.

New formations can be created with the Save Selection As Formation function in the Edit menu.
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1.2.2 Edit player

In the edit player window the color of each individual player can be altered. This is achieved by
selecting a color from the quick color select area or by pressing the more colors button to open a
color dialog.

If it is possible to change the number/name of a player a label edit box is visible to alter the number
of a player. It is also possible to just show the number without a border outline by checking the only
text button, if available.

The players can be resized by changing the zoom level.

For some of the symbols that cannot rotate a facing arrow is available to show where the player is
looking at.

For wheelchairs it is also possible to rotate, by clicking on the rotation circle or by adjusting the
value in the rotation edit box.

Finally the number color can be changed.

Availability of the options varies for the different player symbols.

Pressing the OK button will store the new color, label and rotation of the player and bring you back
to the main window.

The Cancel button will reset the color, label and rotation of the player to its previous values and
bring you back to the main window.

The Default button will load the default values for the colors, label and rotation of the player.
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The Reset button will reset the color, label and rotation of the player to their previous values.

1.2.3 Edit line

The type of a line can be changed, from shot to pass for example, by pressing the up and down
buttons next to the line.

In the edit line window the color of each line player can be altered. This is achieved by selecting a
color from the quick color select area or by pressing the more colors button to open a color dialog.

The arrow at the end of a line can be removed or made visible by selecting the arrow checkbox.

If you want a curved line check the curved box.

Finally the thickness of a line can be changed from 1 to 5.

Pressing the OK button will store the new color and appearance and bring you back to the main
window.

The Cancel button will reset the color and appearance to its previous values and bring you back to
the main window.

The Default button will load the default values for a line, but will not change the line type.

The Reset button will reset the color and appearance of a line to their previous values.
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1.2.4 Edit ellipse

When the solid checkbox is checked, the ellipse will have a solid color, which you can change by
selecting a color from the color box or by pressing the more colors button below the color box.

If the solid box isn't checked the ellipse will be transparent, the field colors will shine through the
ellipse, the colors can be altered and removed from an ellipse by either selecting or altering the red,
green and blue color values.
The lock option will change the three colors together.

Pressing the clear button will create an ellipse with 100% transparency, or in other words only the
border will be visible, deselecting the border will result in an invisible ellipse.

By selecting the border checkbox a border will be drawn, thickness and color can changed with the
available options.

Pressing the OK button will store the new color and bring you back to the main window.

The Cancel button will reset the color to its previous value and bring you back to the main window.

The Default button will load the default values for an ellipse.

The Reset button will reset the color etc... of an ellipse to its previous value.
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1.2.5 Edit polygon

When the solid checkbox is checked, the polygon will have a solid color, which you can change by
selecting a color from the color box or by pressing the more colors button below the color box.

If the solid box isn't checked the polygon will be transparent, can be altered and removed from a
polygon by either selecting or altering the red, green and blue color values.
The lock option will change the three colors together.

Pressing the clear button will create a polygon with 100% transparency, or in other words only the
border will be visible, unselecting the border will result in an invisible polygon.

By selecting the border checkbox a border will be drawn, thickness and color can changed with the
available options.

Pressing the OK button will store the new color and bring you back to the main window.

The Cancel button will reset the color to its previous value and bring you back to the main window.

The Default button will load the default values for a polygon.

The Reset button will reset the color etc... of a polygon to its previous value.
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1.2.6 Edit text

In the edit text window, text to be added to a sketch can be typed and altered.

The font can be adjusted, by selecting the font name, size and style.

Additional font colors are available by pressing the More Colors... button.

By checking the border checkbox, the text will be drawn in a box. The color of the border can be
changed by pressing the More Colors... button.

To give the text a background color check the background box. The color of the background can be
changed by selecting a different color from the color box or by pressing the More Colors... button.

The sample area will show a preview of the selected font. 

Pressing the OK button will store the new text and bring you back to the main window.

The Cancel button will bring you back to the main window, no changes will be made.

The Default button will load the default values for a sketch text.

The Reset button will reset the values for a sketch text its previous values.
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1.3 The edit text tab

When the text tab is selected the text can be edit, also the associated sketch is visible.

With the text edit buttons above the sketch the text can be formatted.

If the Animation only checkbox is checked the current sequence will not be printed.

The Add Sequence button can be used to insert a new sequence after the current sequence.

And the Delete Sequence button can be used to delete the current sequence.

The type box can be used to switch between plays, drills, templates and formations.
If the play Type is Template a "New Play" button is visible so you can create a new play from the
current template.

With the category box categories within the play or drill section can be selected.

With the play name box the different plays within the current category can be selected.

And finally with the sequence buttons you can navigate through the current play.
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1.4 The play list tab

When the play list tab is selected, you can create, edit or export a play list.

Plays and drills are added to the play list by choosing List - Add play to play list, this will add the
current play to the play list. Alternatively you can use CTRL+L or on the overview tab bring up the
pop-up menu and select, add to play list.

You can also add complete categories to the play list by choosing List - Add category to play list,
this will add the current category to the play list.

You can give a play list a name by filling in a play list title.

Deleting a play from the list is done by selecting a play from the list and pressing the delete button.

Pressing the clear list button will give you a new list to start with.

Plays can be dragged up and down the list by clicking and holding down the mouse button on the
play you want to move.

Clicking on the category or name header of the list will order the list be category or name ascending.

The type box can be used to switch between plays, drills, templates and formations.

With the category box categories within the play or drill section can be selected.
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With the play name box the different plays within the current category can be selected.

And finally with the sequence buttons you can navigate through the current play.
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2 File Menu Options

2.1 Adding a new play

To add a play go to the File menu and choose New Play.

When in the Add Play window: 

Start with choosing a type from the type drop down list.

Choose a category from the drop down list or add a category by typing over the current category
with a new category.

After choosing or adding a category fill in a new play name, as this must be a unique name a list of
all play names currently in use is shown.

Selecting one of the available fields and pressing the Ok button brings you back to the main window
with the new play selected.  

Additional plays can be found at the Baseball Playbook Homepage.
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2.2 New play from template

 

 

If the selected play type is Template, then you can directly create a new play from this template by
choosing the file menu New Play From Template or by pressing the New Play button.

To create a new play from a template, change the type, category or  the play name.

A new type can be selected from the drop down list.

The category can be updated by selecting another category from the drop down list, or a new
category can be added by over typing the current category.

2.3 New play list

By selecting the File - New option when on the play list tab you can start a new play list.

If your previous play list has been altered then you will be asked if you want to save the changes.
Otherwise the play list is cleared directly.

2.4 Open plays

To open a play go to the File menu and choose Open...

From the Open menu *.EBP and *.Bak files can be opened and loaded into the Baseball Playbook
Database.

If the play name of the new play already exists in the database the New Play name window is
shown. This allows you to :
1.Alter the play name.
2.Skip/Cancel the loading of the play.
3.Replace the play in the database with the new play.
Additional plays can be found at the Baseball Playbook Homepage.
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If the Edit text tab is selected it is also possible to load text files (*.TXT and *.RTF). The contents of
text files is appended to the text in the text window.

2.4.1 New play name

In the New play name window a play can be given a new unique name so it can be loaded in the
database.

If a new play name is typed the play can be stored in the database by pressing the OK button.

When a backup file is opened you can choose to skip the current play and continue with the next
play in the file by pressing the Skip button.

To avoid pressing the Skip button all the time you can press the Skip All button, this will skip all play
names already in your database, but load all the other plays.

It is also possible to replace the plays in the database by the plays being loaded by pressing the
Replace button.

As with the Skip All button there is also a Replace All button to avoid pressing the Replace button all
the time.

Pressing the Cancel button will end the loading of the file/play and all other plays in the file.

2.5 Open play list

To open a play list select the play list tab, go to the File menu and choose Open...

From the Open menu you can select *.LST and *.CLT files. Where the *.LST files only contain a list
of the plays and the *.CLT files contain a list of the plays and the complete description of the plays
and drills in the list.
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When Opening a *.LST file:
A play might not be in your database, when this is the case you will be asked if you want to continue
loading the play list.
If your answer is No the play list will not be loaded into the play and drills database.

When opening a *.CLT file, or complete list file:
If the play name of the new play already exists in the database the Skip replace window is shown.
This allows you to :
1.Skip/Cancel the loading of the play.
2.Replace the play in the database with the new play.

2.5.1 Skip replace play window

Here you can choose to skip the loading of a play, with the same name as a play in your play
database, and continue with the next play in the file by pressing the Skip button.

To avoid pressing the Skip button all the time you can press the Skip All button, this will skip all play
names already in your database, but load all the other plays.

It is also possible to replace the plays in the database by the plays being loaded by pressing the
Replace button.

As with the Skip All button there is also a Replace All button to avoid pressing the Replace button all
the time.

Pressing the Cancel button will end the loading of the plays in the file, not the play list.

2.6 Save plays

To save a play go to the File menu and choose Save...

In the save menu plays can be saved in *.EBP files.
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The default file name is the play name of the play.

After saving the file can be distributed to other users of the program, for example as an attachment
in an e-mail.

2.7 Save play list

To save a play list select the play list tab, go to the File menu and choose Save...

From the Save menu you can select *.LST and *.CLT files. Where the *.LST files only contain a list
of the plays and the *.CLT files contain a list of the plays and the complete description of the plays
and drills in the list.

The default file name is the title of the play list.

2.8 Export

Export image 

To export an image in JPG or BMP format go to the File menu and choose Export...

Choose Image... or Image 200%... to save the current sketch in BMP, PNG or JPG format.
Choosing 200% will save the image at double size.

The default file name is the play name of the play with the sequence number attached.

After saving the image it can be loaded in image editors or word processors.

The appearance of the images can be changed on the export tab of the preferences menu option.

Export play or category

You can also export a complete play or category in formats like HTML and PDF.

Depending on your choice the export play or export category dialog will be displayed.

2.8.1 Exportplay

This option will export the current play.

There are 4 export options for a play, depending on what you want choose one of the tabs.

HTML will export the play in HTML format with static images.

PDF will export the play in PDF format.

GIF will export the animation as an animated GIF linked in an HTML file or as a separated GIF file.

FLASH will export the animation as a flash movie linked in an HTML file or as a separated swf file.

The default file name is the play name of the selected play.
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After saving the play in HTML format with static images the file can be used to import the play in all
modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the play.

2.8.1.1 Exportplayhtml

This option will export the current play in HTML format.

The following option can be set:
If the Show header checkbox is checked a header is added to the HTML file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.
The page width in pixels can be changed by setting a new value.
If  "Open in default browser" is checked, the play, when exported, will be shown in your internet
browser.

Pressing the Ok button will save the play in html format. The default file name is the play name of
the selected play.

After saving the play in HTML format with static images the file can be used to import the play in all
modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the play.
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2.8.1.2 Exportplaypdf

This option will export the current play in PDF format.

The following options can be set:
If the Show Header checkbox is checked a header is added to the PDF file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.

Pressing the Ok button will save the play in PDF format. The default file name is the play name of
the selected play.

To decrease the file size of the PDF file, you can deselect the Include fonts checkbox and lower the
image quality (not recommended).
If  the program detects a pdf reader, the option "Open in reader" is visible, if checked, the play,
when exported, will be shown in your pdf reader.

PDF files can be opened with the free Adobe Acrobat Reader. If you are experiencing problems
opening PDF files, please download the latest free version of Adobe Acrobat Reader. 
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2.8.1.3 Exportplaygif

This option will export the current play in animated GIF.

The following options can be set:
Use transparent color, if checked only the changes in the frames will be saved in the animation file
resulting in a smaller file size.
Loop animation, keep on playing the animation.
Play animation x times, Repeat playing the animation a x number of times.

The time a frame is shown can be set, there are 4 kinds of frames:
The first frame of the animation.
A normal frame, these are intermediate frames created by the application to get from one sequence
to an other and the sequences where the animation only checkbox is checked.
A sketch frame, the sequence where the animation only checkbox is not checked.
And the last frame of the animation.

When the Within html page checkbox is checked the following options are available:
If the Show Header checkbox is checked a header is added to the HTML file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.
If  "Open in default browser" is checked, the play, when exported, will be shown in your internet
browser.

The page width in pixels can be changed by setting a new value.

Pressing the Ok button will save the play in GIF format with a html page if selected. The default file
name is the play name of the selected play.
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2.8.1.4 Exportplayflash

This option will export the current play in flash (file format swf).

The following options can be set:
Show buttons, if checked you can also change the button colors by clicking the Color... button.
The time a frame is shown can be set, there are 4 kinds of frames:
The first frame of the animation.
A normal frame, these are intermediate frames created by the application to get from one sequence
to an other and the sequences where the animation only checkbox is checked.
A sketch frame, the sequence where the animation only checkbox is not checked.
And the last frame of the animation.
If the "Try using anti-alias" option is checked the program will try to apply an anti-alias filter on the
flash animation, which might give the animation a smoother look. As this will take a lot of time,
make sure you are happy with the non anti aliased animation first, before applying this filter.

When the Within html page checkbox is checked the following options are available:
If the Show Header checkbox is checked a header is added to the HTML file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.
If  "Open in default browser" is checked, the play, when exported, will be shown in your internet
browser.

The page width in pixels can be changed by setting a new value.

Pressing the Ok button will save the play in swf (flash) format with a html page if selected. The
default file name is the play name of the selected play.

2.8.2 Exportcategory

This option will export the current category.
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There are 2 export options for a play, depending on what you want choose one of the tabs.

HTML will export the play in HTML format with static images.

PDF will export the play in PDF format.

The default file name is the category name of the selected category.

After saving the category in HTML format with static images the file can be used to import the play
in all modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the play.

2.8.2.1 Export category html

This option will export the current category in HTML format.

The following option can be set:
One page, if checked all the plays in the category will be placed in one html file, otherwise the plays
will be placed in separate html files with a separate index.
If the one page option is selected you can choose to add a contents part to the beginning of the file.
If the Show header checkbox is checked a header is added to the HTML file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.
The page width in pixels can be changed by setting a new value.
If  "Open in default browser" is checked, the category, when exported, will be shown in your internet
browser.

Pressing the Ok button will save the play in html format. The default file name is the name of the
selected category.
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After saving the category in HTML format with static images the file can be used to import the html
file in all modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the category/play.

2.8.2.2 Export category pdf

This option will export the current category in PDF format.

The following options can be set:
Show a contents page.
If the Show Header checkbox is checked a header is added to the PDF file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
Each play in the category can be started on a new page, by checking the checkbox.
To use unformatted text check the Use plain text checkbox.

Pressing the Ok button will save the category in PDF format. The default file name is the name of
the selected category.

To decrease the file size of the PDF file, you can deselect the Include fonts checkbox and lower the
image quality (not recommended).
If  the program detects a pdf reader, the option "Open in reader" is visible, if checked, the category,
when exported, will be shown in your pdf reader.

PDF files can be opened with the free Adobe Acrobat Reader.
If you are experiencing problems opening PDF files, please download the latest free version of
Adobe Acrobat Reader. 
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2.9 Export play list

When on the Play List tab this option will export the current play list.

There are 2 export options for a play, depending on what you want choose one of the tabs.

HTML will export the play list in HTML format with static images.

PDF will export the play list in PDF format.

The default file name is the title of the plat list.

After saving the play list in HTML format with static images the file can be used to import the play
list in all modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the play.

2.9.1 Export list html

This option will export the current play list in HTML format.

The following option can be set:
One page, if checked all the plays in the play list will be placed in one html file, otherwise the plays
will be placed in separate html files with a separate index.
If the one page option is selected you can choose to add a contents part to the beginning of the file.
If the Show header checkbox is checked a header is added to the HTML file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
To use unformatted text check the Use plain text checkbox.
The page width in pixels can be changed by setting a new value.
If  "Open in default browser" is checked, the play list, when exported, will be shown in your internet
browser.
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Pressing the Ok button will save the play in html format. The default file name is the title of the play
list.

After saving the play list in HTML format with static images the file can be used to import the html
file in all modern word processors. 

The file format of the images used with the HTML export can be set in the export tab of the
preferences menu option. The images part of the play will be saved with the sequence number
added to the filename. Images will be saved in a separate folder with the name of the category/play.

2.9.2 Export play list pdf

This option will export the current play list in PDF format.

The following options can be set:
Show a contents page.
If the Show Header checkbox is checked a header is added to the PDF file, containing a logo and
the category.
The logo can be changed on the export tab of the preferences menu option.
Each play in the category can be started on a new page, by checking the checkbox.
By selecting Start each play on a new page, every play will be exported on a new page.
To use unformatted text check the Use plain text checkbox.

Pressing the Ok button will save the category in PDF format. The default file name is the name of
the selected category.

To decrease the file size of the PDF file, you can deselect the Include fonts checkbox and lower the
image quality (not recommended).
If  the program detects a pdf reader, the option "Open in reader" is visible, if checked, the play list,
when exported, will be shown in your pdf reader.

PDF files can be opened with the free Adobe Acrobat Reader.
If you are experiencing problems opening PDF files, please download the latest free version of
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Adobe Acrobat Reader. 

2.10 Play info

To view, add or update additional play information go to the File menu and choose Play Info...

Information that can be entered include:
Is it a play or drill or a template.
The number of balls and players required for a drill.
Additional categories if a drill is multi functional (shooting, passing and dribbling).
The minimum age group.
And your own personal opinion of the quality of a play.
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2.11 Copy plays

To copy the current play go to the File menu and choose Copy Play

To copy a play either the drill category or the play name must be changed.  A new type can be
chosen from the drop down list.

The category can be updated by selecting another category from the drop down list, or a new
category can be added by over typing the current category.

A new play name can be typed in the play name box, as this must be a unique name a list of all play
names currently in use is shown.

2.12 Delete plays

To delete the current play go to the File menu and choose Delete Play.

When deleting a play the visible play will be removed from the Baseball Playbook Database. No
restore is possible.
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2.13 Rename plays

To update the type, category and or the name of the current play go to the File menu and choose
Rename Play.

A new type can be chosen from the drop down list.

The drill category can be updated by selecting another category from the drop down list, or a new
category can be added by over typing the current category.

To update a play name type a new play name in the update play name box, as this must be a
unique name a list of all play names currently in use is shown.
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2.14 Print

To print a play or a category go to the File menu and choose Print.

Print:
Before printing you can select between printing the current play or the current category.
Selecting the preview option will give you a preview of the print, printing from the preview window is
the same as printing with the image quality at its lowest.

Page Settings:
You can choose to print a header with a logo.The logo can be changed on the export tab of the
preferences menu option.
When you print a category you can add a contents page.
When you want to change the page header text on the content page from Playbook to for example
the name of the team you coach you can alter the Header text.
Each play can be started on a new page when printing a category.
In column mode you can choose to print in newspaper layout.
You can choose to print in rows or a number of columns. To print 1 sketch on a page choose
columns, and set the columns number to 1.

Sequence settings:
Check the No text box if you don't want to print any text.
And check the Hide playname header if you don't want to print those.
Finally you can alter the image quality of the sketch, for a normal printer the second position gives
good results.
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Pressing the Setup button will allow you to change or setup your printer.

Pressing the Ok button will start the printing or show the preview, you can follow the progress with
the progress bar.

You can suppress a sequence from being printed by checking the animation only checkbox on the 
edit drawing tab or the edit text tab. 

The old print method can also be selected on the export tab of the preferences menu option.

2.14.1 Printer setup

To change the printer setup, press the setup button in the print window.

This window differs per printer and operating system.

Usually you can change the printer, choose the paper layout and switch between color or gray scale
printing.

2.15 Print play list

To print a play list, on the play list tab, go to the File menu and choose Print.

Print:
Selecting the preview option will give you a preview of the print, printing from the preview window is
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the same as printing with the image quality at its lowest.
You can also choose to only print the list (without the sketches and additional text), handy for quick
references.

Page Settings:
You can choose to print a header with a logo. The logo can be changed on the export tab of the
preferences menu option.
You can add a contents page.
When you want to change the page header text on the content page from the play list title to for
example the name of the team you coach you can alter the Header text.
Each category can be started on a new page and within a category each play can be started on a
new page.
In column mode you can choose to print in newspaper layout.
You can choose to print in rows or a number of columns. To print 1 sketch on a page choose
columns, and set the columns number to 1.

Sequence settings:
Check the No text box if you don't want to print any text.
And check the Hide playname header if you don't want to print those.
Finally you can alter the image quality of the sketch, for a normal printer the second position gives
good results.

Pressing the Setup button will allow you to change or setup your printer.

Pressing the Ok button will start the printing or show the preview, you can follow the progress with
the progress bar.

You can suppress a sequence from being printed by checking the animation only checkbox on the 
edit drawing tab or the edit text tab. 

2.16 Send play

In default mode the program will try to use your standard e-mail client like Outlook Express or
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Thunderbird.

You can choose between an EBP or PDF file attachment.

EBP is playbooks own file format; the receiver needs a playbook (same or higher version number)
program to be able to view this. With the EBP format the play can be animated and edited by the
receiver.
PDF files can be read with the free Adobe Acrobat Reader.

To start your e-mail client press the Send button.

When you enter your mail preferences then the internal e-mail client of the playbook program will be
used and the following options will be available.

You can choose between an EBP or PDF file attachment or HTML with inline images.

EBP is playbooks own file format; the receiver needs a playbook (same or higher version number)
program to be able to view this. With the EBP format the play can be animated and edited by the
receiver.
PDF files can be read with the free Adobe Acrobat Reader.
HTML files with inline images can be viewed with most e-mail clients like outlook express, most web
mail readers however will cut the e-mail in multiple parts.

After choosing the file format press Next to enter the receivers e-mail address.
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The To and CC (Carbon Copy) fields can be filled with one or more e-mail addresses (separate the
e-mail addresses with a ;).
Pressing the more (...) button behind the TO or CC field will open the built-in e-mail address book.

The pre filled subject field can be altered and some additional information can be entered in the
Text area.

Connect to the Internet and press the send button.

If you are on dial-up, when done don't forget to disconnect.

2.16.1 e-mail address book

In the address book you can store e-mail addresses and define groups of addresses to sent mail to.

Only available if the internal e-mail client is used.
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2.16.1.1 select e-mail addresses

You can select e-mail address or groups by checking the check boxes in front of them. Groups can
be recognized by the * in front of them.

On this tab an e-mail address can also be added, edited or deleted.

To add an e-mail address, press the new button. After filling in the first name, last name and a valid
e-mail address press the add button for validation and if all is correct the e-mail address is added to
the list.

To edit an e-mail address, select an e-mail address from the list and alter the first name, last name
or the e-mail address. When the update button is pressed the address is validated and changed.

An e-mail address can be removed from the address book by selecting it from the list and pressing
the delete button.
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2.16.1.2 select edit mail groups

First select the e-mail group you want to edit.

Then select the e-mail address by checking the check boxes in front of them.
All address of a group can be removed by pressing the clear button.
This can be undone by pressing the reset button, which will bring up the previous selection.
A group can be removed by selecting it from the list and pressing the delete button.

To add a group, press the new button. After filling in name press the add button to add the new
group to the list.

To edit a group name over type the name at the bottom and press the update button.

2.17 Backup

There are two backup options.

1. Backup all the plays and drills by selecting Backup - Playbook.

2. Backup the plays and drills in the current category by selecting Backup - Category.
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2.17.1 Backup database

There are two ways to backup the database.

1. To backup all the plays currently in the database go to the File menu and choose Backup -
Playbook.

2. Every twenty-fifth time the program starts you will be asked to make a backup, which is highly
recommended.

To start a backup of your current plays press the OK button.
To skip a backup press the Cancel button.
Checking a check box can disable the automated backup question, this is not recommended.

After pressing Ok you can choose the file destination in a save file dialog.   

Although backups seem to be time consuming, you would not be the first to have an accident, like a
power failure, resulting in a corrupted database and loss of work.

The steps on how to recover a database are described here.

2.17.2 Backup category

To backup all the plays currently in the database go to the File menu and choose Backup -
Category.

To start a backup of your current current category press the OK button.
To skip a backup press the Cancel button.
After pressing Ok you can choose the file destination in a save file dialog.   
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The steps on how to load a backup file into a playbook database are described here.

2.18 Exit program

To exit the Baseball Playbook program go to the File menu and choose Exit or click on the X in the
upper right corner of the window.

Before exiting the program all modifications to the plays and drills are stored in the database.
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3 Edit Menu Options

3.1 Save selection as formation

If 2 or more players are selected on the edit drawing tab the Save Selection As Formation option
becomes available in the Edit menu.

A preview of the formation is given and a new category and formation name can be selected.

The category can be updated by selecting another category from the drop down list, or a new
category can be added by over typing the current category.

A new formation name can be typed in the new formation name box, as this must be a unique name
a list of all formation names currently in use is shown

After saving the formation by pressing the Ok button, the formation becomes available in the Add
formation list.

3.2 Undo

To undo an action go to the Edit menu and choose Undo or press CTRL-Z.

Undo is available for drawing and text editing.
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3.3 Redo

To Redo an action previously undone go to the Edit menu and choose Redo or press CTRL-Y.

Redo is only available for drawing editing; the option Use undo history list on the miscellaneous tab
of the preferences dialog should be selected.

3.4 Undo history

To undo or redo more than one action select the actions from the undo redo history list and press
Undo or Redo.

Undo, redo history is only available while editing a drawing and the option Use undo history list on
the miscellaneous tab of the preferences dialog should be selected.

3.5 Copy, cut  and paste

To use copy, cut or paste go to the edit menu and choose the corresponding option.

Copy Image:
When copy image is clicked the current play sketch is copied to the clipboard. The image can then
be paste/imported in almost all word processors and graphics programs.
Holding down shift when copying an image will result in a double sized copy of the current sketch.
The appearance of the images can be changed on the export tab of the preferences menu option.

Copy Text:
When copy text is clicked the selected text to the clipboard. The text can then be paste/imported
into the baseball playbook or other applications.
Copy text is available in the overview tab and the edit text tab.

Cut:
When cut is clicked the selected text is moved to the clipboard. The text can then be paste into the
baseball playbook or other applications.
Cut is only available for text editing.
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Paste:
When paste is clicked the text, if available, is moved from the clipboard to the cursor position in the
text screen.
Paste is only available for text editing.

Select All:
In text editing when select all is clicked all the text will be selected.

When editing a sketch all players will be selected.

Select all is only available for text and drawing editing.
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4 Option Menu Options

4.1 Flip sketch

When on the drawing tab you can flip an image.

Choose Options-Flip and the sketch will be flipped.

You can choose to flip one sequence or the whole play on the miscellaneous tab of the preferences
menu.

4.2 Mirror sketch

When on the drawing tab you can mirror an image.

Choose Options-Mirror and the sketch will be mirrored.

You can choose to mirror one sequence or the whole play on the miscellaneous tab of the
preferences menu.

4.3 Change font

To change the font of the text, choose the Font option in the Option Menu.

With the Font option you can alter the font within a text.

This option is only available for text editing.
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4.4 Change symbols

By clicking on one of the player icons (circle, triangle, cross, wheelchair, square or arm symbol) the
player icon can be altered. 

Pressing the OK button will store the new appearance of the players and bring you back to the main
window. The changed player icons are now available in the edit drawing tab, note that players
already on the field do not change.

The Cancel button will reset the appearance of the players to their previous values and bring you
back to the main window.

The Default button will load the default appearance for the players.

The Reset button will reset the appearance of the players to their previous values.
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4.5 Field color

Select if you want the changes you made to be applied to the whole play or only the current
sequence.

If you want a black & white field or a black & white field with black & white players then check the
corresponding option.

You can alter the colors by first selecting the area on the field and then selecting a color from the
quick color select area or by pressing the more colors button to open a color dialog.

Pressing the OK button will store the new colors and bring you back to the main window.

The Cancel button will reset the colors to their previous values and bring you back to the main
window.

The Default button will load the default values for the field colors.

The Reset button will reset the colors to their previous values.

4.6 Preferences

To set a few default preferences go to the Options menu and choose Preferences...

The following sections are available in the preferences window.

Default font, select a default font for text and sketch text.
Mail identity, for activating the internal send mail option.
Export, select how images headers will look when exporting them.



Baseball Playbook54

Miscellaneous, some additional settings.

4.6.1 Default font

Options - Preferences - Default font

The default font for both the text and the sketch text can be adjusted, by selecting the font name,
size and style.

Additional font colors are available by pressing the More... button.

The sample area will show a preview of the new default font. 

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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4.6.2 Mail identity

Options - Preferences - Mail Identity

You can choose to use the internal e-mail client by checking the Use internal mail client checkbox.

Before the internal mail client is activated, your mail identity must be correctly filled in.

The name field should be filled with your name or the name of your organization.
The e-mail field should contain a valid e-mail address, for example yourname@yourprovider.not. 

The outgoing mail (SMTP) server should contain the smtp address of your provider for example
smtp.yourprovider.not; the combination of e-mail address and smtp address is often checked for
validation.
If your (SMTP) server requires authentication or uses a different port then go to the SMTP Server
Settings by pressing the More button.
If you are on a network connection, there might be a network mail/proxy server, in that case provide
the address of this server.

Note that this is basically the same information you would provide in the Internet settings for
outlook. 

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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4.6.2.1 SMTP server settings

Options - Preferences - Mail Identity - More

Some times a SMTP server requires authentication, you can check the checkbox if you need this
option.
If checked you can fill in your smtp server user name, you will be asked for your password when
actually sending an e-mail.

Some providers also use a different port, just fill in the different port number to change this.

Pressing the OK button will store the changes and bring you back to the Mail identity window.

The Cancel button will bring you back to the main window, no changes will be made.
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4.6.3 Export settings

Options - Preferences - Export

The following options can be set here.

Printing:
By checking the Use old print form checkbox, the print window and the print functions will change to
version 008 of the playbook program.

Logo:
You can change the logo used in the header when exporting to PDF, html format or printing by
clicking the browse button and selecting a new images. The image will be resized by the program to
fit, images with a width of 260 and a height of 180 pixels work fine (13:9).
By clicking the Default button the logo will be reset to the default logo

Image file format for export:
You can choose between the PNG and JPG file format.
PNG is a loss less file format, and works very well for diagrams. However some mail clients don't
support it.
JPEG is a lossy file format, and more suited for photographs, which means the quality of a diagram
will not be perfect.
For playbook sketches the file size of a PNG file is up to ten times smaller than a JPEG file of the
same sketch.
If the "Try using anti-alias on exported images" option is checked the program will try to apply an
anti-alias filter on the image, which might give the image a smoother look.

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.
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The Cancel button will bring you back to the main window, no changes will be made.

4.6.4 Miscellaneous settings

Options - Preferences - Miscellaneous

A few default settings can be changed here.

Overview tab:
When checked all sequences of the play are shown in the overview tab, otherwise the sequences
made to make the animation smoother (with the animation only checkbox checked) are hidden.

Edit Drawing tab:
If the option "Try moving players to new position when adding a sequence" is checked the program
will try to move players and balls to their next position, when a new last sequence is added. 
Checking the option "Use undo history list", will make the Redo and the Undo, redo history list
functions available on the edit drawing tab, if this option is not selected the undo function will
"remember" only the last action.
If the "Keep line buttons down" option is checked, a line drawing button will stay down after
completing a line, this might speed up the drawing of a sketch.
With Flip/Mirror all sequences of play checked, the whole play will be flipped or mirrored instead of
just the current sequence, when flipping or mirroring in the edit drawing tab.

Play List tab:
When checked the play list will not be automatically reloaded on start of the program. This will result
in a blank play list when the program is started.

Players:
When the option "Anti-alias rotated player symbols" is checked, some symbols like the wheelchair
will be drawn with anti-alias enabled.
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One of the problems with rotated player symbols is the readability of the player number, when
anti-alias is selected the readability is improved.
However the sketch redraw speed will be slower, Anti-alias is disabled in the animation mode.
The players can be resized by selecting a different zoom factor; the zoom factor is only applied on
newly added players.

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.

4.7 Default colors

To change the default colors used by Baseball Playbook choose the Default colors option in the
Option Menu.

With the field tab you can alter the field colors.

And with the players tab you can alter the color of the players.

4.7.1 Change default field colors

When the field tab is selected in the color options window the default colors of the field can be
adjusted.

By clicking on the field the four different areas (border, field, three point and bucket) of the field can
be selected

You can alter the default color by selecting a color from the quick color select area or by pressing
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the more colors button to open a color dialog.

Pressing the OK button will store the new colors and bring you back to the main window.

The Cancel button will reset the colors to their previous values and bring you back to the main
window.

The Default button will load the default values for the colors for both the field and the players.

The Reset button will reset the colors to their previous values.

Colors only appear when the field is not in black and white.

4.7.2 Change default player colors

When the players tab is selected in the color options window the default color of the players can be
adjusted.

By clicking on a player you can alter between defensive and offensive players.

You can alter the default color by selecting a color from the quick color select area or by pressing
the more colors button to open a color dialog.

Pressing the OK button will store the new colors of the players and bring you back to the main
window.

The Cancel button will reset the colors  of the players to their previous values and bring you back to
the main window.

The Default button will load the default values for the colors for both the field and the players.
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The Reset button will reset the colors of the players to their previous values.

Colors only appear when the field is not in black and white.
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5 List Menu Options

5.1 Add play to play list

Plays and drills are added to the play list by choosing List - Add play to play list, this will add the
current play to the play list. 

A short message will be shown when a play is added to the play list.

When a play is already in the play list a warning is shown and the play will not be added to the play
list.

5.2 Add category to play list

Categories of plays and drills are added to the play list by choosing List - Add category to play list,
this will add all the plays and drills in the current category to the play list. 

A short message will be shown when a category is added to the play list.

When a play of the current category is already in the play list a warning is shown and the play will
not be added to the play list.

5.3 Clear play list

By selecting the List - Clear play list when on the play list tab you can start a new play list.

If your previous play list has been altered then you will be asked if you want to save the changes.
Otherwise the play list is cleared directly.
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6 Special Menu Options

6.1 Animation

You can make players in a play move by clicking the Animation option in the Special menu.

When more than one sequence for the current play is available the program will calculate the
movement of players and balls to their new position.

You can use the Play, Pause, Stop, Previous and Next button to navigate through the play. 

The text can be hidden or shown by pressing the T- or T+ button.

Checking the sketch box will animate the play with sketches, the play will pause whenever a new
sequence starts.

If the Loop box is checked the play will run continuously until Pause, Stop or Cancel is pressed.

The best results for an animation are obtained by using numbered players and not to many coaches
and balls. 
Also keep in mind that the program only calculates straight-line movement.

Pressing the Cancel button will let you leave the animation window and return to the main screen.
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Full screen animation is achieved by pressing the maximize button on the top right corner of the
animation window.

Next to the functions described above, a sketch function is available.
Sketching is done by pausing the play and holding down the left mouse button while moving over
the play. The drawing color can be altered by selecting a different color in the drop down list of the
remote control. The sketch can be cleared by clicking with the left mouse button outside the play.

The remote can be moved or brought back by clicking the right mouse button anywhere in the
window; this will also clear the sketch.

Note that in high resolution you will need a fast computer to achieve good results with full screen
color animation.

6.2 Plugin

If a plugin is available you can click the Plugin option in the Special menu.

In the plugin window you can select and preview the available plugins.

A plugin can be selected from the list.

When selected a short description about the plugin is available and the plugin fields can be viewed
on the right. 

Selecting  Active : Yes will activate plugin, to deactivate select No.

More information about plugins might be available at www.jes-soft.com.

http://www.jes-soft.com/


Part

VII



Baseball Playbook68

7 Miscellaneous

7.1 Trial period

After a 30-day trial period some functions of the playbook program will only be available for
registered users.

The registered version of Baseball Playbook has the following extras:
Creation and export of play lists.
Export to animation in flash format.
Snap to grid when drawing a sketch. 
Export of a drill in PDF file format. 
Sending a play with e-mail. 
Changing of the line color and line thickness. 
Add text to a play sketch. 
Use of different colors with polygons and ellipses. 
Export of play sketches in PNG file format.
Curved movement lines.
Dragging of line points.
Undo and redo on the edit drawing tab.
Auto placement of players when adding a new last sequence.
And more.... 

After the trial period you can prevent this message from popping up by checking a check box. 

More information on registering this product can be found at:
www.jes-soft.com

7.2 Adobe Acrobat Reader

PDF files can be opened with the free Adobe Acrobat Reader.
If you are experiencing problems opening PDF files, please download the latest free version of Adobe Acrobat
Reader.

Get Adobe Acrobat Reader 

7.3 Baseball playbook homepage

On the Baseball Playbook Homepage you will find the following information:

1.Updates of the program.

2.Additional plays and drills in zip format.

3.Links for downloading new versions.

4.Reviews of the playbook program.

The homepage address is http://www.jes-soft.com/baseball/ 

You can submit your plays as an attachment in *.EBP format to baseball@jes-soft.com, received
plays will become part of the database and might be published on the website.

http://www.jes-soft.com/baseball/register.html
http://www.adobe.com/prodindex/acrobat/readstep.html
http://www.jes-soft.com/baseball/
http://www.jes-soft.com/baseball/
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7.4 Drag and drop

Dragging and dropping of a player is done by selecting a player with the left mouse button.
While keeping the left mouse button down the player can be moved to its (new) position.
When the mouse button is released and the player is above the field the player is dropped on the
field. 

7.5 Drawing lines

Lines can be drawn by pushing one of the movement buttons.

If a movement button is pressed you can click with the left mouse button on the field, this will start
the movement line.
Additional parts of the line can be added by clicking with the left mouse button on the field.

Clicking with the right mouse button will end the line.

See the symbols for an explanation of the different lines.

7.6 E-mail attachments

With Netscape:

To attach a file to an outgoing email message: 

1.In the message composition window, click and hold Attach (the paperclip) and then choose File. 

2.Select the file you want to attach and click Open.

The file appears in the attachments list.

With Outlook Express:

In the new message window. To insert a file, click the Insert menu, click File Attachment, and then
double-click the file you want to send.

Additional plays can be found at the Baseball Playbook Homepage.

7.7 Gif file format

The Gif file format uses a maximum of 256 colors and a very strong compression algorithm which keeps the
files small.

The Gif component in the playbook software is based, in part, on the work of Anders Melander.

7.8 Load backup file

To restore or load the plays in a Baseball Playbook Backup file (PLAYS.BAK, ALLPLAYS.BAK) go
to the File menu and choose Open.
Change the file filter (Files of type:) to Baseball Playbook Backup (*.bak) select the file you want to
open and press Open. 

If a play in the backup file is already in the database the New play name window is shown. This
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allows you to:
1.Alter the play name.
2.Skip the current play, but load the next.
3.Skip all plays in the database, but load all the others.
4.Replace the current play.
5.Replace all plays in the database.
6.Cancel the loading of the rest of the file.

This function can also be used to load the files with plays located at the Baseball Playbook
Homepage.

7.9 Logo

 

The above logo is the default logo shown in the upper left corner of each printed page, exported play, category
or list. 

Instead of this logo you can use your own default logo by replacing the file logo.bmp in the installation folder
of Baseball Playbook.

The logo.bmp file should be in windows .BMP format with a width of 270, a height of 180 pixels and a color
depth of 256 colors.
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7.10 Printing a play or the complete playbook

To print a play or the complete playbook go to the File menu and choose Print.

Before printing you can select between printing the current play, the current category or all plays in
the database.

Selecting the preview button will give you a preview of the print, printing from the preview window is
the same as printing with the image quality at its lowest.

You can alter the layout of a print between rows (3 sequences), columns (2 sequences) or full page
(1 sequence).
In full-page layout, no text and 1 play diagram per page is printed.

With the A4 and Letter buttons the most common print formats can be selected.

Sometimes not all text will fit in a row or column, making the font-size smaller will give you more
text space on a page.

If the Print button is selected you can alter the image quality of the sketch, for a normal printer the
second position gives good results.
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When you want to change the page header from Playbook to for example the name of the team you
coach you can alter the Header text.

You can use the Mode button to alter the memory use of images during printing.

Pressing the Ok button will start the printing or show the preview, you can follow the progress with
the progress bar.

You can suppress a sequence from being printed by checking the animation only checkbox on the 
edit drawing tab or the edit text tab. 

To customize a page even more you can alter the logo.

7.10.1 Printer mode

In the print mode window you can change the way memory is used during printing. If the default
mode 3 doesn't work try mode 1 (print straight from memory). Mode 2, 3 and 4 use conversion
routines and might alter the raster and colors of the images slightly.

Print mode 1, print straight from memory, in the default color depth.
Print mode 2, print in 24bit color depth.
Print mode 3, print in 8bit color depth.
Print mode 4, print in 4bit color depth.
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7.11 Register

If the playbook program is not registered, you can input your activation key here.

After a 30-day trial period some functions of the playbook program will only be available for
registered users.

The registered version of Baseball Playbook has the following extras:
Creation and export of play lists.
Export to animation in flash format.
Snap to grid when drawing a sketch. 
Export of a drill in PDF file format. 
Sending a play with e-mail. 
Changing of the line color and line thickness. 
Undo, redo on the edit drawing tab.
Add text to a play sketch. 
Use of different colors with polygons and ellipses. 
Export of play sketches in PNG file format.
Curved movement lines.
Dragging of line points.
Auto placement of players when adding a new last sequence.
And more.... 

More information on registering this product can be found at:
www.jes-soft.com

7.12 Selecting players

When none of the movement buttons is selected, you can select a player or a line by clicking it in
the field window.

To select multiple players and lines, lines hold down the CTRL button while clicking on the
players/lines.

http://www.jes-soft.com/baseball/register.html
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You can also select an area of the field by holding down the Shift key and use the main mouse
button to resize a selection rectangle.

Finally all players/lines can be selected by choosing Edit - Select All or by pressing CTRL-A.

A selected player or line will have big dots, showing it has been selected.

Players or lines that are selected can be deleted by pressing the Delete button on the Edit drawing
tab.

Selected players or lines can be unselected by clicking them again with the left mouse button.

7.13 Shortcut keys

An overview of the shortcut keys available.

General

Shortcut keys Action Remarks

F1 Show context sensitive help Every dialog/windows should
have its own help topic

TAB/SHIFT TAB Walk through the items on the
screen

Arrow keys, END, Page Up,
Page Down, Home

Might change a control

Overview tab

Shortcut keys Action Remarks

CTRL+O Open play or backup file You might have to change the
file filter.

CTRL+P Open the print dialog

CTRL+C Copy all text to clipboard

CTRL+I Copy sketch to clipboard Check Option-Preferences to set
anti-alias

CTRL+SHIFT+I Copy double size sketch to
clipboard

Check Option-Preferences to set
anti-alias

CTRL+L Add current play to play list

CTRL+N Open animation dialog with
current play

Edit Drawing tab

Shortcut keys Action Remarks

CTRL+O Open play or backup file You might have to change the
file filter.

CTRL+P Open the print dialog

CTRL+I Copy sketch to clipboard Check Option-Preferences to set
anti-alias

CTRL+SHIFT+I Copy double size sketch to Check Option-Preferences to set
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clipboard anti-alias

CTRL+A Select all items on the sketch

CTRL+Z Undo

CTRL+Y Redo If use undo history list is checked

CTRL+ALT+Z Open Redo/Undo History list If use undo history list is checked

CTRL+mouse When selecting items and
holding down the CTRL key you
can add or remove items from
the selection

SHIFT+mouse While holding the SHIFT button
down, a dashed rectangle is
drawn on the sketch all items
within the rectangle will be
selected

CTRL+SHIFT+mouse While holding the CTRL+SHIFT
buttons down, a dashed
rectangle is drawn on the sketch
all items within the rectangle will
be added to the selection

DELETE Delete the selected item(s)

Arrow keys Nudge selected items(s) If you want to move the selected
items over a greater distance
use the mouse

CTRL+L Add current play to play list

CTRL+N Open animation dialog with
current play

Edit Text tab

Shortcut keys Action Remarks

CTRL+O Open play or backup file You might have to change the
file filter.

CTRL+P Open the print dialog

CTRL+C Copy selected text to clipboard

CTRL+Z Undo

CTRL+X Cut selected text to clipboard

CTRL+C Copy selected text to clipboard

CTRL+V Paste text on the clipboard on
cursor position or replace
selected text

CTRL+B Toggle bold font on/off

CTRL+I Toggle italic font on/off

CTRL+U Toggle underlined font on/off

CTRL+L Left align paragraph

CTRL+E Center paragraph

CTRL+R Right align paragraph

ALT+1 Place j at cursor position Wingdings 2 font needs to be
installed

ALT+2 Place k at cursor position Wingdings 2 font needs to be
installed
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ALT+3 Place l at cursor position Wingdings 2 font needs to be
installed

ALT+4 Place m at cursor position Wingdings 2 font needs to be
installed

ALT+5 Place n at cursor position Wingdings 2 font needs to be
installed

ALT+6 Place o at cursor position Wingdings 2 font needs to be
installed

ALT+7 Place p at cursor position Wingdings 2 font needs to be
installed

ALT+8 Place q at cursor position Wingdings 2 font needs to be
installed

ALT+9 Place r at cursor position Wingdings 2 font needs to be
installed

ALT+0 Place s at cursor position Wingdings 2 font needs to be
installed

CTRL+N Open animation dialog with
current play

Play List tab

Shortcut keys Action Remarks

CTRL+O Open play list or complete play
list file

You might have to change the
file filter.

CTRL+P Open the play list print dialog

CTRL+L Add current play to play list

CTRL+N Open animation dialog with
current play

7.14 Text edit buttons

 Cut the selected text and place the text in the clipboard 

 Copy the selected text and place the text in the clipboard 

Paste the text in the clipboard at the current cursor position 

Undo the last action

Make the selected text bold, or start bold text

Make the selected text italic, or start italic text

 Underline the selected text, or start underlined text
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Place a bullet in front of the selected paragraph(s) or start a bullet list

Align the text left

Center the text

Align the text right

7.15 The symbols

Offense 

Defense 

Wheelchair 

Coach 

Ball

Ball basket

Pylon

Base

Passing line, direction of the ball

Direction of the player

Movement of player with ball 

Hit

Ellipse



Baseball Playbook78

Polygon 

Text 

7.16 Zip and unzip

Here are some points about Zip.

A *.ZIP file is a file which contains one or more compressed files. Compression is very useful in keeping
download times low.

This format is standard in windows XP but for older computers you will need a zip program.

To decompress/unzip a zip file you will need a Zip/Unzip program. Zip programs can be found on the Internet,
you can find several with the following links:
www.tucows.com
www.zdnet.com
www.shareware.com

Sometimes when unzipping a file you will get an error like: This file is corrupted.
Usually this means that you have not downloaded the complete zip file.
Downloading it again will often solve the problem.

7.17 Abbreviations

P = Pitcher
C = Catcher
1B = First base
2B = Second base
3B = Third base
SS = Short stop
LF = Left field
CF = Center field
RF = Right field
RC = Right center field
LC = Left center field
R = Referee
1..10= Batsmen

http://www.tucows.com/
http://www.zdnet.com/
http://www.shareware.com/


Part

VIII



Baseball Playbook80

8 Frequently Asked Questions

8.1 How do I complete the registration process ?

After installing the software, which can be downloaded from one of the links at:
http://www.jes-soft.com/baseball/download.html

Please follow the steps below:
1.Start the program, Click Start, All Programs, Baseball Playbook v010 and click Baseball Playbook
010
2.Locate and click on the register menu option (next to the help). 
3.Fill in your registration code you received by e-mail and click Ok 
4.After registration the register option has disappeared. 

8.2 How do I download and open additional plays and drills ?

First go the download play page at:
http://www.jes-baseball.com/downplay.html 

Click on the set of plays you like to download, when asked to open or save choose save and save the
file (remember where you put it). Sometimes you have to right click on the link to be able to save the
zip file.

---- You might skip the part if you are using win Xp
As the plays are placed in a zip file you will need an unzip program, which you can find at
http://www.tucows.com or
http://www.winzip.com
Some zip programs are free others are shareware.

Start your unzip program and open the file with plays you just downloaded.

Extract the plays (*.ebp or *.bak file) to a (temporary) folder/directory, remember the place.
---- 

Start the playbook program.
For the *.ebp files use the File-Open function.
For the *.bak files use the File-Open function and change the file type to Baseball Playbook Backup
(*.bak) or to *.* to see the file you like to open. 

After that follow the instructions on screen or press F1 for additional help.

8.3 How do I submit a play ?

The following is a list of steps describing sending plays to other playbook users via E-mail, while not
using the built in e-mail functions:

· Locate the play you want to sent and choose File - Save, this will save the play in *.EBP format

· Write down in which folder/map and under which name you saved the play 

· Start your E-mail program 

http://www.jes-soft.com/baseball/download.html
http://www.jes-baseball.com/downplay.html
http://www.tucows.com
http://www.winzip.com
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· Fill in the e-mail address, and any comments you might like to sent with the play 

· To attach the play click on the paper clip or attach option 

· Browse through your files and folders until you have found the file to attach 

· Select the file and press Ok 

· Connect to the internet 

· Press the sent Button

Note: if you submit multiple files you might want to zip them first, this will decrease the file size by
80%..

8.4 Players/lines that are placed on a court will not go onto the court
where I want them.

Check if the Snap checkbox on the edit drawing tab is unchecked.
If it is not unchecked please remove the check mark and try again. 

When the snap function is checked, an invisible grid is used to align players and lines. The size of the
grid can be altered by changing the value behind the check box. It really helps if you want to draw
straight lines, circles, squares or align text.

8.5 Error on loading Winsock2 library (WS2_32.DLL)...

For those that want to try running this program under windows 95 (not supported).

This version of Baseball Playbook needs the Winsock2 library.
However this library is not standard with windows 95.

You can download the Winsock2 library from the following page:
Windows Socket 2 Update

http://support.microsoft.com/kb/182108/EN-US/
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